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Paper Set 1 · 31 May 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
କାର M ବି ନ୍ଦୁ  A ରୁ  ବି ନ୍ଦୁ  B କୁ  ଯାତ୍ରା  କରି ବା ପାଇଁ  7 ଘଣ୍ଟା ସମୟ ନି ଏ । ଯଦି  ଏହା ଏହାର
ମୂ ଳ ବେଗ ଠାରୁ  22.6 km/hr କମ ବେଗରେ ସମାନ ଦୂ ରତା ଯାତ୍ରା  କରି ଥାନ୍ତା ତେବେ
ଏହାକୁ  8 ଘଣ୍ଟା ସମୟ ଲାଗି ଥାନ୍ତା । ବି ନ୍ଦୁ  A ଏବଂ B ମଧ୍ୟରେ ଦୂ ରତା କେତେ?

A.  1052.5 km

B.  1132.5 km

C.  1265.6 km

D.  1376.7 km

✓

Q2 Quant
ଏକ କାର ପୁ ନେରୁ  ଅହମଦନଗର ପର୍ଯ୍ୟ ନ୍ତ ହାରାହାରି  60 km/h ବେଗରେ 180 km
ଅତି କ୍ର ମ କରେ । ଫେରି ବା ସମୟରେ, କାରଟି  ଟ୍ରା ଫି କ ଜାମର ସମ୍ମୁଖୀନ ହୁ ଏ ଏବଂ ହାରାହାରି
30 km/h ବେଗରେ ଯାତ୍ରା  କରେ । ଏହି  ରାଉଣ୍ଡ ଟ୍ରି  ପର ସାମଗ୍ରି  କ ହାରାହାରି  ବେଗ କେତେ
ଅଟେ?

A.  30 km/h

B.  35 km/h

C.  40 km/h

D.  45 km/h

✓

Q3 Quant
ଗୋଟି ଏ ବି ଦ୍ୟାଳୟରେ ବାଳକ ଓ ବାଳି କାଙ୍କ ସଂଖ୍ୟାର ଅନୁ ପାତ 3:2 ଅଟେ । ଯଦି  ବାଳକଙ୍କ
ସଂଖ୍ୟା ବାଳି କାଙ୍କ ସଂଖ୍ୟା ଅପେକ୍ଷା 120 ଅଧି କ ହୁ ଏ, ତେବେ ସେହି  ବି ଦ୍ୟାଳୟର ବାଳକଙ୍କ
ସଂଖ୍ୟା ନି ର୍ଣ୍ଣ ୟ କର ।

A.  240

B.  300

C.  360

D.  400

✓

Q4 Quant

2.2 m × 2.0 m × 1.5 m ମାତ୍ରା  ବି ଶି ଷ୍ଟ ଆୟତଘନାକାର ଟାଙ୍କି କୁ  0.25 m ବ୍ୟାସାର୍ଦ୍ଧ  ଏବଂ
0.28 m ଉଚ୍ଚତା ବି ଶି ଷ୍ଟ ଏକ ସି ଲି ଣ୍ଡରାକୃ ତି  ବାଲ୍ ‌ଟି  ସାହାଯ୍ୟରେ ପାଣି  ଭର୍ତ୍ତି କରାଯାଉଛି  ।
ଟାଙ୍କି ଟି କୁ  ପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  କେତେ ବାଲ୍ ‌ଟି  ପାଣି  ଆବଶ୍ୟକ ହେବ? (π = 22/7 ବ୍ୟବହାର
କର)

A.  110

B.  115

C.  120

D.  125

✓

Q5 Quant
8ଟି  ସଂଖ୍ୟାର ହାରାହାରି  42 ଅଟେ । ଯଦି  ଆଉ ଗୋଟି ଏ ସଂଖ୍ୟା ଯୋଗ କରାଯାଏ ଏବଂ
ନୂ ତନ ହାରାହାରି  40 ହୁ ଏ, ତେବେ ଯୋଗ କରାଯାଇଥି ବା ସଂଖ୍ୟାଟି  କେତେ?

A.  24

B.  23

C.  22

D.  21

✓

Q6 Quant
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ଅନୁ ପାତ 4:7 ସହି ତ ସମାନ?

A.  28:49

B.  98:105

C.  44:73

D.  54:70

✓

Q7 Quant
4 ଟି  କଲମ ଓ 3 ଟି  ନୋଟବୁ କର ମୂ ଲ୍ୟ ₹86 ଅଟେ ଯେତେବେଳେକି  2 ଟି  କଲମ ଓ 5 ଟି
ନୋଟବୁ କର ମୂ ଲ୍ୟ ₹78 ଅଟେ । ଗୋଟି ଏ କଲମର ମୂ ଲ୍ୟ କେତେ?

A.  ₹12

B.  ₹14

C.  ₹16

D.  ₹18

✓

Q8 Quant
ମନୋଜ ତାଙ୍କ ମାସି କ ଆୟର 62.5% ଖର୍ଚ୍ଚ  କରନ୍ତି  ଏବଂ ପ୍ର ତି  ମାସରେ ₹1236 ସଞ୍ଚୟ
କରନ୍ତି  । ମନୋଜର ମାସି କ ଆୟ କେତେ?

A.  ₹3196

B.  ₹3216

C.  ₹3236

D.  ₹3296

✓

Q9 Quant
ଗୋଟି ଏ ଜ୍ୟାକେଟର ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟ ₹2,500 ଅଟେ । ଜଣେ ଦୋକାନୀ ଏହା ଉପରେ
ଯଥାକ୍ର ମେ 20% ଏବଂ 10% ର ଦୁ ଇଟି  କ୍ର ମି କ ରି ହାତି  ପ୍ର ଦାନ କରନ୍ତି  । ଜ୍ୟାକେଟ୍ ‌ର ଚୂ ଡ଼ାନ୍ତ
ବି କ୍ର ୟ ମୂ ଲ୍ୟ କେତେ?

A.  ₹2,000

B.  ₹1,800

C.  ₹1,750

D.  ₹1,700
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✓

Q10 Quant
ଜଣେ ଦୋକାନୀ ସାମଗ୍ରୀ ର ମୂ ଲ୍ୟକୁ  30% ଅଧି କ କରି  ଧାର୍ଯ୍ୟ  କରି  ସେହି  ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟ
ଉପରେ 10% ଓ 5% ର ଦୁ ଇଟି  କ୍ର ମାଗତ ରି ହାତି  ପ୍ର ଦାନ କରନ୍ତି  । ଯଦି  ଏହି ପରି  ଏକ
ସାମଗ୍ରୀ ର ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟ 260 ଟଙ୍କା ହୁ ଏ, ତେବେ ଦୋକାନୀଙ୍କ ଦ୍ୱାରା ଅର୍ଜିତ ଲାଭର
ପ୍ର ତି ଶତ (ଦୁ ଇଟି  ଦଶମି କ ସ୍ଥାନ ପର୍ଯ୍ୟ ନ୍ତ) ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

A.  11.15 %

B.  22.30 %

C.  12.25 %

D.  15.15 %

✓

Q11 Quant
ଗୋଟି ଏ ପାଇପ ଏକ ଟାଙ୍କି କୁ  6 ମି ନି ଟ୍ ‌ରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରୁ ଥି ବା ବେଳେ ଅନ୍ୟ ଏକ ପାଇପ
ସେହି  ଭର୍ତ୍ତି ଟାଙ୍କି କୁ  9 ମି ନି ଟ୍ ‌ରେ ଖାଲି  କରି ପାରେ । ଯଦି  ଟାଙ୍କି ଟି  ଖାଲି  ଥି ବା ଅବସ୍ଥାରେ
ଉଭୟ ପାଇପକୁ  ଏକାସାଙ୍ଗରେ ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ର ଏକ-ତୃ ତୀୟାଂଶ ପୂ ର୍ଣ୍ଣ  ହେବା
ପାଇଁ  କେତେ ମି ନି ଟ୍  ସମୟ ଲାଗି ବ?

A.  6

B.  12

C.  18

D.  24

✓

Q12 Quant
ଜଣେ ଦୋକାନୀ ଏକ ସାମଗ୍ରୀ ର ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟକୁ  ଏହାର କ୍ର ୟ ମୂ ଲ୍ୟ ଅପେକ୍ଷା 50% ଅଧି କ
ରଖନ୍ତି  । 14% ଲାଭ ପାଇବା ପାଇଁ  ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟ ଉପରେ କେତେ ପ୍ର ତି ଶତ ରି ହାତି  ପ୍ର ଦାନ
କରାଯି ବା ଆବଶ୍ୟକ?

A.  24 %

B.  21 %

C.  27 %

D.  26 %

✓

Q13 Quant
ଅକ୍ଷୟଙ୍କ ପାଖରେ ₹1,300 ଅଛି  । ସେ ଏହି  ଟଙ୍କାକୁ  ତାଙ୍କ ଦୁ ଇ ପୁ ଅ ଅର୍ଜୁ ନ ଓ କାର୍ତ୍ତିକଙ୍କ
ମଧ୍ୟରେ ଭାଗ କରି ଦେଇ, ବାର୍ଷିକ 8% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ବି ନି ଯୋଗ କରି ବାକୁ
କହି ଥି ଲେ । ଏହା ଦେଖି ବାକୁ  ମି ଳି ଲା ଯେ, ଯଥାକ୍ର ମେ 13 ଓ 14 ବର୍ଷ  ପରେ ଅର୍ଜୁ ନ ଓ
କାର୍ତ୍ତିକଙ୍କୁ  ସମାନ ସମୂ ଳସୁ ଧ ମି ଳି ଥି ଲା । ତେବେ ଅକ୍ଷୟ କାର୍ତ୍ତିକଙ୍କୁ  କେତେ ଟଙ୍କା (₹ ରେ)
ଦେଇଥି ଲେ?

A.  625

B.  675

C.  475

D.  775

✓

Q14 Quant
15, 10, 12 ଓ 13 ମଧ୍ୟରୁ  ପ୍ର ତ୍ୟେକରେ x ଯୋଗ କଲେ ଏହି  କ୍ର ମରେ ପ୍ରା ପ୍ତ ସଂଖ୍ୟାଗୁ ଡ଼ି କ
ସମାନୁ ପାତି  ହୋଇଥାଏ । ଯଦି  9x : y :: y : (2x − 7) ଏବଂ y > 0 ହୁ ଏ, ତେବେ y ର ମୂ ଲ୍ୟ
କେତେ?

A.  60

B.  46

C.  41

D.  65

✓

Q15 Quant
ଗୋଟି ଏ ଛୋଟ ଗାଁ ର ଜନସଂଖ୍ୟା 3000 ଅଟେ । ଗାଁ ର ପ୍ର ତ୍ୟେକ ଲୋକଙ୍କୁ  ପ୍ର ତି ଦି ନ 80
ଲି ଟର ପାଣି  ଆବଶ୍ୟକ ହୁ ଏ । ଗାଁ ରେ 16 m × 10 m × 12 m ମାପ ବି ଶି ଷ୍ଟ ଏକ ପାଣି  ଟାଙ୍କି
ଅଛି  । ଟାଙ୍କି ଟି  ଥରେ ପୂ ର୍ଣ୍ଣ  ହୋଇଗଲେ, ଗାଁ ର ଲୋକଙ୍କ ପାଇଁ  କେତେ ଦି ନ ପାଇଁ  ପାଣି
ଯଥେଷ୍ଟ ହେବ?

A.  10

B.  6

C.  12

D.  8
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✓

Q16 Quant
200 cm ବାହୁ  ବି ଶି ଷ୍ଟ ଏକ ସମବାହୁ  ତ୍ରି  ଭୁ ଜର କ୍ଷେତ୍ର ଫଳ (cm² ରେ) କେତେ?
(  ବ୍ୟବହାର କର )

A.  14,100

B.  15,200

C.  16,800

D.  17,300

✓

Q17 Quant
ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  

B.  

C.  

D.  

✓

Q18 Quant
ଯଦି  1, 1, 1, 5, 9, 8, 7, 9, 9, 63, 4, 5, 6, 88, 8, 4, 44, 6, 6, 6, 9, 9, 9 ଏବଂ 1 ର ଗରି ଷ୍ଠକ "v" ହୁ ଏ, ତେବେର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  

B.  

C.  

D.  
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✓

Q19 Quant

ସରଳ କର 

A.  29

B.  25

C.  33

D.  32

✓

Q20 Quant
A ଦୁ ଇଟି  ନି ର୍ଦ୍ଦିଷ୍ଟ ଷ୍ଟେସନ ମଧ୍ୟରେ 20 ଦି ନରେ ରେଳ ଟ୍ରା କ ବି ଛାଇପାରି ବେ ଏବଂ B ସମାନ କାମକୁ  16 ଦି ନରେ କରି ପାରି ବେ । C ଙ୍କ ସାହାଯ୍ୟରେ ସେମାନେ 2 ଦି ନରେ କାମ କରି ଥି ଲେ ।
ତେବେ, C ଏକାକୀ ଏହି  କାମ କେତେ ଦି ନରେ କରି ପାରି ବେ?

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
ଇଷ୍ଟ ଇଣ୍ଡି ଆ କମ୍ପାନୀର ରାଜନୈ ତି କ ଓ ପ୍ର ଶାସନି କ କାର୍ଯ୍ୟା ବଳୀକୁ  ସ୍ୱୀକୃ ତି  ଦେଇ ଭାରତୀୟ
ବ୍ୟାପାର ଉପରେ ବ୍ରି  ଟି ଶ ନି ୟନ୍ତ୍ରଣର ସୂ ତ୍ର ପାତ କରି ଥି ବା କେଉଁ ଟି  ପ୍ର ଥମ ଆଇନ (Act)
ଅଟେ?

A.  ପି ଟ୍ସ  ଇଣ୍ଡି ଆ ଆଇନ

B.  ରେଗୁ ଲେଟିଂ  ଆଇନ 1773

C.  ଚାର୍ଟ ର ଆଇନ 1813

D.  ଭାରତୀୟ ପରି ଷଦ ଆଇନ 1861

✓

Q22 GA
16 ଜୁ ଲାଇ 2025ରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ପ୍ର ଥମ ଭାରତୀୟ ହକି  ଖେଳାଳି  ପଲି ଗ୍ରା ସ୍
ମ୍ୟାଜି କ୍  ସ୍କି ଲ୍  ଆୱାର୍ଡ  (Poligras Magic Skill Award) ଜି ତି ଥି ଲେ?

A.  ରାଣୀ ରାମପାଲ

B.  ଦୀପି କା ସେହରାୱତ

C.  ବନ୍ଦନା କଟାରି ଆ

D.  ସବି ତା ପୁ ନି ଆ

✓

Q23 GA
ପ୍ର ଦତ୍ତ ଭୌଗଳି କ ସୀମା ଅନୁ ଯାୟୀ, ନି ମ୍ନ ଲି ଖି ତ ରାଜ୍ୟଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଓଡ଼ି ଶାର
ଦକ୍ଷି ଣରେ ଅବସ୍ଥି ତ?

A.  ପଶ୍ଚି ମବଙ୍ଗ

B.  ଛତି ଶଗଡ଼

C.  ଆନ୍ଧ୍ରପ୍ର ଦେଶ

D.  ଝାଡଖଣ୍ଡ

✓

Q24 GA
କେଉଁ  ବି ଶ୍ୱବି ଦ୍ୟାଳୟକୁ  ଏହାର ଗ୍ରୀ ନ-କ୍ୟାମ୍ପସ ଡ୍ରା ଇଭ (2024-25,, ଜୁ ନ 2025 ରେ
ରି ପୋର୍ଟ  କରାଯାଇଥି ବା) ପାଇଁ  ଓଡ଼ି ଶାର 'ପ୍ର କୃ ତି  ମି ତ୍ର ' ପୁ ରସ୍କାର ପ୍ର ଦାନ କରାଯାଇଥି ଲା?

A.  ଉତ୍କଳ ବି ଶ୍ୱବି ଦ୍ୟାଳୟ

B.  ରେଭେନ୍ସା  ବି ଶ୍ୱବି ଦ୍ୟାଳୟ

C.  ବ୍ର ହ୍ମପୁ ର ବି ଶ୍ୱବି ଦ୍ୟାଳୟ

D.  ସମ୍ବଲପୁ ର ବି ଶ୍ୱବି ଦ୍ୟାଳୟ
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✓

Q25 GA
ଓଡ଼ି ଶା, କୃ ଷି  ନେତୃ ତ୍ୱ ସମ୍ମି ଳନୀର କେଉଁ  ସଂସ୍କରଣରେ 'କୃ ଷି  ନେତୃ ତ୍ୱ ପୁ ରସ୍କାର'
(Agriculture Leadership Award) ଗ୍ର ହଣ କରି ଥି ଲା?

A.  14 ତମ

B.  15 ତମ

C.  16 ତମ

D.  17 ତମ

✓

Q26 GA
2000 ମସି ହାରୁ  ଓଡ଼ି ଶା ରାଜନୀତି ରେ ପ୍ରା ଧାନ୍ୟ ବି ସ୍ତାର କରି ଥି ବା ଆଞ୍ଚଳି କ ରାଜନୈ ତି କ
ଦଳକୁ  ଚୟନ କର ।

A.  ଇଣ୍ଡି ଆନ ନ୍ୟାସନାଲ କଂଗ୍ରେ ସ (INC)

B.  କମ୍ୟୁ ନି ଷ୍ଟ ପାର୍ଟି ଅଫ ଇଣ୍ଡି ଆ (ମାର୍କ୍ସ ବାଦୀ) [CPI(M)]

C.  ଭାରତୀୟ ଜନତା ପାର୍ଟି (BJP)

D.  ବି ଜୁ  ଜନତା ଦଳ (BJD)

✓

Q27 GA
2025 ଜୁ ଲାଇରେ କେନ୍ଦ୍ର କ୍ୟାବି ନେଟ ଭାରତର ସ୍ପୋର୍ଟିଂ ଇକୋସି ଷ୍ଟମକୁ  ରୂ ପାନ୍ତରି ତ
କରି ବା ଲକ୍ଷ୍ୟରେ କେଉଁ  ପ୍ର ମୁ ଖ ନୀତି କୁ  ମଞ୍ଜୁ ରୀ ପ୍ର ଦାନ କରି ଥି ଲେ?

A.  ନ୍ୟାସନାଲ ଫି ଜି କାଲ ଫି ଟନେସ ପଲି ସି  2025

B.  ନ୍ୟାସନାଲ ୟୁ ଥ ଆଣ୍ଡ ସ୍ପୋର୍ଟ୍ସ  ମି ଶନ 2025

C.  ନ୍ୟାସନାଲ ସ୍ପୋର୍ଟ୍ସ  ପଲି ସି  2025

D.  ନ୍ୟାସନାଲ ପ୍ଲେ  ଆଣ୍ଡ ୱେଲନେସ ପ୍ରୋ ଗ୍ରା ମ 2025

✓

Q28 GA
କି ଏ ଶ୍ରେ ଷ୍ଠ FIFA ଫୁ ଟବଲ ପୁ ରସ୍କାର 2025 ରେ ଶ୍ରେ ଷ୍ଠ FIFA ମହି ଳା ଗୋଲକି ପର (The
Best FIFA Women’s Goalkeeper) ଭାବରେ ମନୋନୀତ ହୋଇଥି ଲେ?

A.  ହାନ୍ନା ହାମ୍ପଟନ (Hannah Hampton)

B.  ଜି ଆନଲୁ ଇଜି  ଡୋନାରୁ ମ୍ମା (Gianluigi Donnarumma)

C.  ଆଇଟାନା ବୋନମାଟି  (Aitana Bonmatí)

D.  ସାରି ନା ୱି ଗମ୍ୟାନ (Sarina Wiegman)

✓

Q29 GA
ଅକ୍ଟୋବର 2025 ରେ, କେଉଁ  ଭାରତୀୟ ସହର UNESCO କ୍ରି  ଏଟି ଭ ସି ଟି ଜ ନେଟୱାର୍କ
(Creative Cities Network) ରେ ସାମି ଲ ହେବାରେ ଭାରତର 9 ମ ସହର
ହୋଇପାରି ଛି ?

A.  ଲକ୍ଷ୍ନୌ

B.  ଜୟପୁ ର

C.  ଅହମ୍ମଦାବାଦ

D.  ବାରଣାସୀ

✓

Q30 GA
ଭାରତର କେଉଁ  ପ୍ର କାରର ଅରଣ୍ୟ ଉଷ୍ମ  ଓ ଆର୍ଦ୍ର  ଅଞ୍ଚଳରେ ଦେଖି ବାକୁ  ମି ଳେ, ଯେଉଁ ଠାରେ
ବାର୍ଷିକ ବୃ ଷ୍ଟି ପାତ 200 cm ରୁ  ଅଧି କ ଏବଂ ହାରାହାରି  ବାର୍ଷିକ ତାପମାତ୍ରା  22oC ରୁ
ଅଧି କ ଅଟେ?

A.  କ୍ରା ନ୍ତୀୟ କଣ୍ଟାଳି ଆ ଅରଣ୍ୟ

B.  କ୍ରା ନ୍ତୀୟ ପର୍ଣ୍ଣ ମୋଚି  ଅରଣ୍ୟ

C.  କ୍ରା ନ୍ତୀୟ ଚି ରହରି ତ ଅରଣ୍ୟ

D.  ପାର୍ବ ତ୍ୟ ଅରଣ୍ୟ

✓

Q31 GA
କି ଣ୍ଵ ନ ସମୟରେ ଇଷ୍ଟରେ ଥି ବା ପାଇରୁ ଭେଟ କେଉଁ ଥି ରେ ରୂ ପାନ୍ତରି ତ ହୁ ଏ?

A.  କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ ଏବଂ ଜଳ

B.  ଇଥାନଲ ଓ କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ

C.  ଇଥାନଲ ଓ ଅକ୍ସି ଜେନ

D.  ଗ୍ଲୁ କୋଜ ଏବଂ କାର୍ବ ନ ଡାଇଅକ୍ସାଇଡ

✓

Q32 GA
ଭାରତର ବି ଶାଳ ସମତଳ ଅଞ୍ଚଳରେ ଦେଖାଯାଉଥି ବା ପୁ ରାତନ ଏବଂ ନୂ ତନ ପଟୁ  ମୃ ତ୍ତି କା
(alluvial deposits) କୁ  କ’ଣ କୁ ହାଯାଏ?

A.  ରେଗୁ ର ଏବଂ ତରାଇ

B.  ଦୋଆବ ଏବଂ ଚୋସ

C.  ମଲାର ଏବଂ ଭି ଲ

D.  ଭାଙ୍ଗର ଏବଂ ଖାଦର

✓

Q33 GA
ପାରମ୍ପରି କ ଜୀବାଶ୍ମ  ଇନ୍ଧନ ତୁ ଳନାରେ ଆଲକହଲକୁ  ଇନ୍ଧନ ଭାବରେ ବ୍ୟବହାର କରି ବାର
ମୁ ଖ୍ୟ ଲାଭ କ'ଣ?

A.  ଇଞ୍ଜି ନରେ ଆଲକହଲ ବ୍ୟବହାର କରାଯାଇପାରି ବ ନାହିଁ

B.  ଜୀବାଶ୍ମ  ଇନ୍ଧନ ଅପେକ୍ଷା ଆଲକହଲ ଅଧି କ ମହଙ୍ଗା ଅଟେ  

C.  ଆଖୁ  ଭଳି  ନବୀକରଣଯୋଗ୍ୟ ସମ୍ବଳରୁ  ଆଲକୋହଲ ଉତ୍ପାଦି ତ ହୋଇଥାଏ ।

D.  ଜୀବାଶ୍ମ  ଇନ୍ଧନ ତୁ ଳନାରେ ଆଲକହଲରେ ଶକ୍ତି  କମ ଥାଏ

✓

Q34 GA
ବି ପର୍ଯ୍ୟ ୟ ପରି ଚାଳନାରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ସାଂରଚନି କ ପ୍ର ଶମନ ବ୍ୟବସ୍ଥା
ଗଠନ କରେ?

A.  ଜନ ସଚେତନତା ଅଭି ଯାନ

B.  ବି ପର୍ଯ୍ୟ ୟ ପ୍ର ସ୍ତୁତି  ଅଭ୍ୟାସର ଆୟୋଜନ

C.  ନଦୀବନ୍ଧ ଏବଂ ଆଡି ବନ୍ଧ ନି ର୍ମା ଣ

D.  ପ୍ରା ରମ୍ଭି କ ସତର୍କ ତା ପ୍ର ଣାଳୀ ପ୍ର ତି ଷ୍ଠା
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✓

Q35 GA
ଭାରତୀୟ ସମ୍ବି ଧାନର କେଉଁ  ଅନୁ ସୂ ଚୀରେ କେନ୍ଦ୍ର, ରାଜ୍ୟ ଏବଂ ଯୁ ଗ୍ମ  ତାଲି କା ଅଛି ?

A.  ଷଷ୍ଠ ଅନୁ ସୂ ଚୀ

B.  ନବମ ଅନୁ ସୂ ଚୀ

C.  ସପ୍ତମ ଅନୁ ସୂ ଚୀ

D.  ପଞ୍ଚମ ଅନୁ ସୂ ଚୀ

✓

Q36 GA
ଆଗ୍ନେୟ ଉଦଗି ରଣ ସମୟରେ ବି ଗଳି ତ ପଥର ପୃ ଥି ବୀ ପୃ ଷ୍ଠରେ ପହଞ୍ଚି ବା ପରେ ତାହାକୁ
କ'ଣ କୁ ହାଯାଏ?

A.  ମେଣ୍ଟଲ (Mantle)

B.  ଲାଭା (Lava)

C.  ମାଗମା (Magma)

D.  ଟେଫ୍ରା  (Tephra)

✓

Q37 GA
ସଙ୍ଗମ ସାହି ତ୍ୟ ସନ୍ଦର୍ଭ ରେ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଯୋଡ଼ି  ସଠି କ ଭାବରେ ମେଳ ଖାଉଛି ?

A.  ତୋଲକାପି ୟମ (Tolkappiyam)- ଆଠଟି  ସଂକଳନକୁ  ନେଇ ଗଠି ତ

B.  ଏଟ୍ଟୁ ଟ୍ଟୋକାଇ (Ettuttokai) - ତାମି ଲ କବି ତାର ଆଠଟି  ସଂକଳନର ସଂଗ୍ର ହ

C.  ପଟ୍ଟୁ ପଟ୍ଟୁ  (Pattupattu) - ବୀରତ୍ୱପୂ ର୍ଣ୍ଣ  ବି ଷୟବସ୍ତୁକୁ  ବର୍ଣ୍ଣ ନା କରୁ ଥି ବା ଆଠଟି
ସଂକଳନର ଏକ ଅଂଶବି ଶେଷ

D.  ଅକାନାନୁ ରୂ  (Akananuru) - ବ୍ୟାକରଣ ଏବଂ ଅଳଙ୍କାର ଶାସ୍ତ୍ର ସମ୍ବନ୍ଧୀୟ ପ୍ର ବନ୍ଧ

✓

Q38 GA
ଜଣେ ବି ଦ୍ୟାର୍ଥୀ  ଏକ ଅବତଳ ଦର୍ପ ଣର ପୋଲ ଓ ମୁ ଖ୍ୟ ଫୋକସ ମଧ୍ୟରେ ଏକ ବସ୍ତୁକୁ
ରଖି ଲେ । ଏହି  ଅବସ୍ଥାରେ ସୃ ଷ୍ଟି  ହେଉଥି ବା ପ୍ର ତି ବି ମ୍ବକୁ  କେଉଁ  ବୈ ଶି ଷ୍ଟ ସର୍ବୋ ତ୍ତମ ଭାବେ
ବର୍ଣ୍ଣ ନା କରେ?

A.  ବାସ୍ତବ, ପରି ବର୍ଦ୍ଧିତ ଏବଂ ଦର୍ପ ଣ ସମ୍ମୁଖରେ

B.  ଆଭାସୀ, ପରି ବର୍ଦ୍ଧିତ ଏବଂ ଦର୍ପ ଣ ପଛରେ

C.  ବାସ୍ତବ, କ୍ଷୁ ଦ୍ର  ଏବଂ ଦର୍ପ ଣ ସମ୍ମୁଖରେ 

D.  ଆଭାସୀ, କ୍ଷୁ ଦ୍ର  ଏବଂ ଦର୍ପ ଣ ପଛରେ

✓

Q39 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ପ୍ର ଚ୍ଛନ୍ନ ବେକାରୀକୁ  ବ୍ୟାଖ୍ୟା କରେ?

A.  ଏପରି  ଏକ ସ୍ଥି ତି  ଯେଉଁ ଠାରେ ବ୍ୟକ୍ତି ବି ଶେଷ ସେମାନଙ୍କ ଇଚ୍ଛା ଅପେକ୍ଷା କମ ଘଣ୍ଟା
କାର୍ଯ୍ୟ  କରନ୍ତି , ଯାହା ଶ୍ର ମର ଅପପ୍ର ୟୋଗକୁ  ସୂ ଚାଇଥାଏ ।

B.  ଶ୍ର ମର ଚାହି ଦାରେ ଋତୁ ଭି ତ୍ତି କ ପରି ବର୍ତ୍ତ ନ ଯୋଗୁଁ  ସୃ ଷ୍ଟି  ହେଉଥି ବା ଏକ ଅସ୍ଥାୟୀ
ବେକାରୀ ସମସ୍ୟା ।

C.  ଏପରି  ଏକ ପରି ସ୍ଥି ତି  ଯେଉଁ ଠାରେ ଶ୍ର ମି କମାନେ ସେମାନଙ୍କ ପସନ୍ଦ କି ମ୍ବା ଆର୍ଥିକ
ସ୍ଥି ତି ରେ ପରି ବର୍ତ୍ତ ନ ଯୋଗୁଁ  ବାରମ୍ବାର ଚାକି ରି  ପରି ବର୍ତ୍ତ ନ କରନ୍ତି  ।

D.  ଜଣେ ବ୍ୟକ୍ତି  ଦୃ ଶ୍ୟତଃ କାର୍ଯ୍ୟ ରତ ଥାଇ ମଧ୍ୟ ମୋଟ ଉତ୍ପାଦନରେ କୌଣସି
ଅବଦାନ ନ ଦେଉଥି ବା ବେକାରୀ ।

✓

Q40 GA
ନି ମ୍ନ ଲି ଖି ତ କି ଏ ହି ନ୍ଦୁ ସ୍ତାନୀ ଶାସ୍ତ୍ରୀୟ ସଙ୍ଗୀତର ଜଣେ ପ୍ର ସି ଦ୍ଧ ସି ତାର ବାଦକ ଅଟନ୍ତି ?

A.  ସୁ ଲତାନ ଖାନ

B.  ଶକୁ ର ଖାନ

C.  ରମେଶ ମି ଶ୍ରା

D.  ନି ଖି ଲ ବନର୍ଜୀ
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English

✓

Q41 English
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a meaningful and coherent
paragraph.

A. Its clear evidence can be seen in observations of the atmosphere, oceans, ice and living things.
B. We know Earth is warming.
C. By comparing the changes scientists have observed in computer simulations of the climate including or excluding various potential causes,
scientists can work out what or who is responsible for the climate changes.
D. Computer simulations can tell us what the world would have looked like without increases in greenhouse gases and other human
influences, and Earth would not have warmed up like we have seen.

A.  BDAC

B.  ADBC

C.  BADC

D.  CBDA

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

One who leads an austere life

A.  Theist

B.  magician

C.  Ascetic

D.  Misogynist

✓

Q43 English
Select the most appropriate ANTONYM of the underlined word in the given sentence.

Her response was deliberate, measured carefully to maintain diplomatic neutrality amidst growing tensions.

A.  Spontaneous

B.  Calculated

C.  Formal

D.  Conservative

✓

Q44 English
Select the sentence with the correct use of the past perfect tense.

A.
            By the time the train arrived, we left the station.

B.  By the time the train arrived, we had left the station.

C.  By the time the train arrived, we have left the station.

D.  By the time the train arrived, we leaving the station.
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✓

Q45 English
Read the sentence below and identify the one option in which the underlined word is correctly spelled.
“The committee was asked to prepare an exhaustiveley detailed report on student performance.”

A.  exhaustiveley

B.  exhaustively

C.  exhaustivelye

D.  exhaustivly

✓

Q46 English
The following sentence is in direct speech. Complete the sentence in indirect speech.

Direct: Sita said, “I will have been working on this project for five hours by 6 p.m.”
Indirect: Sita said that ___________.

A.  she would have been working on that project for five hours by 6 p.m.

B.  she will have been working on this project for five hours by 6 p.m.

C.  I would have been working on this project for five hours by 6 p.m.

D.  she has been working on this project for five hours by 6 p.m.

✓

Q47 English
Choose the correct proverb to substitute the underlined word segment in the following sentence.

Though the villagers doubted her at first, Kavita’s persistence showed that fair promises and talk cannot replace real results.

A.  empty vessels make the most noise

B.  fine words butter no parsnips

C.  the pen is mightier than the sword

D.  every dog has its day

✓

Q48 English

Read the passage and choose the correct answer to the questions based on it.

Baroque Art emerged in Europe around 1600, primarily in Rome, as a dynamic, dramatic, and emotionally intense reaction against the restrained
classicism of the Renaissance and Mannerism. This style was strategically utilized by the Catholic Church during the Counter-Reformation to
reaffirm its power and engage the emotions of the populace. Characterized by dramatic use of light and shadow (chiaroscuro), intense emotion,
elaborate ornamentation, and a focus on movement, Baroque works sought to overwhelm the viewer. Key figures include the sculptor Bernini,
known for his passionate Ecstasy of Saint Teresa, and the painter Caravaggio, whose intense naturalism and use of tenebrism (extreme
chiaroscuro) revolutionized painting. The style was not monolithic; it flourished differently in Catholic and Protestant countries, demonstrating
adaptability while maintaining its characteristic sense of theatrical grandeur, influencing everything from architecture to music. The movement
created an immersive experience that transformed static spaces into living spectacles of divine and royal authority.

Which of the following best captures the essence of the passage?

A.  The Origins of 17th-Century Italian Sculpture

B.  Baroque Art: Drama, Emotion, and the Aesthetic

C.  The Artistic Legacy of Bernini and Caravaggio

D.  Comparing Renaissance with Baroque Art
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✓

Q49 English
What is the predominant tone of the passage when describing Baroque Art?

A.  Critical and skeptical of its religious intent.

B.  Informative and appreciative of its dramatic qualities.

C.  Detached and purely technical regarding its form.

D.  Subjective and anecdotal about the artists' lives.

✓

Q50 English
Which of the following is explicitly mentioned as a characteristic technique of Baroque painting?

A.  Sfumato (blending colors without harsh lines)

B.  Isometric perspective (used in technical drawings)

C.  Tenebrism (extreme use of light and shadow)

D.  Pointillism (using small, distinct dots of color)

✓

Q51 English
What can be inferred about the Catholic Church's objectives in promoting Baroque Art during the Counter-Reformation?

A.  They wished to promote subdued and cerebral forms of worship.

B.  They aimed to use emotionally overwhelming art to draw adherents.

C.  Their goal was to align entirely with the restrained aesthetic.

D.  They were attempting to discourage large, public artistic displays.

✓

Q52 English
Choose the word from the passage that is an antonym for "subdued."

A.  Intense

B.  Adaptability

C.  Monolithic

D.  Strategic

✓

Q53 English
Which of the following sentences is written in the Active Voice?

A.  Lunch will be served at noon.

B.  The flowers were watered by the gardener.

C.  He easily answered all the difficult questions.

D.  The whole street was flooded by the heavy rain.
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✓

Q54 English
In the following question, a statement has been given with highlighted text. You are required to replace the text with the correct proverb from
the given alternatives.

The manager warned that postponing important decisions can cause serious problems in business matters. He explained that delay could
lead to financial loss and confusion.

A.  a bird in hand is worth two in the bush

B.  delays are not denials

C.  look before you leap

D.  a stitch in time saves nine

✓

Q55 English
Complete the sentence by choosing the correct option.
The view from the mountain top was ......................... breathtaking.

A.  frequently

B.  absolutely

C.  presumably

D.  ultimately

✓

Q56 English
Choose the word opposite in meaning to the underlined word in the given sentence.

After the team finally secured the championship trophy, the locker room was filled with jubilant cheers and celebration.

A.  Proud

B.  Gloomy

C.  Exultant

D.  Triumphant

✓

Q57 English
Select the option that can be used as a one-word substitute for the underlined group of words.

She meticulously prepared for the examination, driven by her determination to achieve something.

A.  mirage

B.  fixation

C.  conviction

D.  aspiration
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✓

Q58 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

O. it's a great ugly thing,
P. with massive metal chimneys
Q. and a tangle of ducts, pipes and valves
R. twice as ungainly and

A.  ORPQ

B.  RPOQ

C.  PROQ

D.  QROP

✓

Q59 English
Select the most appropriate option to fill in the blank.

I try to save _____ money every month.

A.  the little

B.  few

C.  a little

D.  a few

✓

Q60 English
Complete the sentence by inserting the correct article.

____ orchestra from Goa played beautifully during ____ concert yesterday.

A.  The, the

B.  No article needed, the

C.  The, no article needed

D.  No article needed, a
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Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ପରୀକ୍ଷାରେ ବାଳକଟି  ____ ହୋଇ ଲେଖି ବାରୁ  ପରି ଣାମ ଭଲ ହେଲା ନାହିଁ । ''

A.  ନାଚି  ନାଚି

B.  ବାରମ୍ବାର

C.  ତରତର

D.  ଟୋପା ଟୋପା

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଓଡି ଶୀ ଓଡ଼ି ଶାର ପ୍ର ସି ଦ୍ଧ ନୃ ତ୍ୟ ରୂ ପେ ଜଣାଶୁ ଣା ଅଟେ।

A.  The famous dance of Odisha is known as Odissi.

B.  The classical dance of Odisha is Bharatanatyam.

C.  The folk dance of Odisha is Kathak.

D.  The dance of Odisha is Manipuri.

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ପୂ ଜା କରି ବା ପାଇଁ  କେହି  କାହାକୁ  ବାଧ୍ୟ କରି ବା ଉଚି ତ ନୁ ହେଁ  |

A.  No one should force anyone to worship.

B.  No one will force anyone to worship.

C.  No one has forced anyone to worship.

D.  No one should force to worship.

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ପର୍ବ ପର୍ବା ଣି  ସମୟରେ ଯାତ୍ରୀ  ମାନଙ୍କ ସୁ ବି ଧା ଲାଗି  ଅଧି କ ଟ୍ରେ ନ ଚଳାଚଳର ବ୍ୟବସ୍ଥା କରାଯାଏ ।

A.  During festivals, more train services are arranged for the passengers.

B.  More train services are arranged for the convenience of passengers.

C.  During festivals, many train services are arranged for the convenience of passengers.

D.  During festivals, arrangements are made to run more trains for the convenience of passengers.

✓

Q65 Odia
ହେ ଜଗନ୍ନାଥ ! ମୁଁ  ତୁ ମକୁ  ଧନ ମାଗୁ ନାହିଁ - ରେଖାଙ୍କି ତ ପଦ କେଉଁ  ପ୍ର କାର କ୍ରି  ୟାପଦ ?

A.  ଦେଶଜ କ୍ରି  ୟା

B.  ଦ୍ଵି କର୍ମ କ କ୍ରି  ୟା

C.  ନାମଧତୁ  କ୍ରି  ୟା

D.  ପ୍ର ଯୋଜକ କ୍ରି  ୟା
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✓

Q66 Odia
.'ବସି ବା ଠାରୁ  କାଶି ବା ଭଲ' ଏହି  ହି ତବାଣୀର ଅର୍ଥ  କ'ଣ ?

A.  ବସି  ଆରାମ କରି ବା

B.  କି ଛି  କାମ ନ କରି ବା

C.  ଅଳସୁ ଆ ହେବା ଅପେକ୍ଷା କି ଛି  ନା କି ଛି  କାମ କରି ବାରେ ଉପକାରି ତା ଅଛି

D.  କାଶି ବା

✓

Q67 Odia
ଗୋବି ନ୍ଦ ଦଶ ଟଙ୍କା ଦେଇଛି  । ଏହି  ବାକ୍ୟରେ "ଦଶ' କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ?

A.  ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  ପରି ମାଣବାଚକ ବି ଶେଷଣ

C.  ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

D.  ସୂ ଚନାବାଚକ ବି ଶେଷଣ

✓

Q68 Odia
"ଛାତି  ଫୁ ଲେଇ ଚାଲି ବା"-ଏହି  ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କ'ଣ ?

A.  ଭୟଭୀତ ହେବା

B.  ଗର୍ବ  ଦେଖାଇବା

C.  ଦୁଃ ଖ ପ୍ର କାଶ କରି ବା

D.  ଲଜ୍ଜି ତ ହେବା

✓

Q69 Odia
‘ଅର୍ଦ୍ଧ ଚନ୍ଦ୍ର ଦେବା’ – ରୁ ଢି ଟି  ର ସଠି କ୍  ଅର୍ଥ  ଲେଖ ।

A.  ଗଳା ଧକ୍କା

B.  ଗଳାମାଳୀ

C.  ଗଳାହାର

D.  ଗଳା ଚି ପି ବା

✓

Q70 Odia
‘ଗହମ ନି ଦ’ - ରୂ ଢ଼ି ର ଅର୍ଥ  ଲେଖ ।

A.  ଛାଇ ନି ଦ

B.  ନି ଦ୍ରା ହୀନତା

C.  ଗାଢ଼ ନି ଦ

D.  ଅଳ୍ପ ନି ଦ
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✓

Q71 Odia

ପ୍ର ଦତ୍ତ ଅନୁ ଚ୍ଛେଦ ଆଧାରରେ ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ପ୍ର ଶ୍ନ  ଗୁ ଡି କର ସଠି କ ଉତ୍ତର ଦି ଅ|

ଆମ ପୃ ଥି ବୀର ପ୍ରା କୃ ତି କ ପରି ବେଶ ତଥା ପାରି ପାର୍ଶ୍ଵିକ ସନ୍ତୁଳନକୁ  ଅକ୍ଷୁ ର୍ଣ୍ଣ  ରଖି ବା ପାଇଁ  ବନ୍ୟପ୍ରା ଣୀ ସଂରକ୍ଷଣ ବର୍ତ୍ତ ମାନ ସମୟର ଏକ ଅପରି ହାର୍ଯ୍ୟ  ଆବଶ୍ୟକତା ହୋଇପଡ଼ି ଛି । ମାତ୍ର
ଦୁ ର୍ଭା ଗ୍ୟବଶତଃ, ଦ୍ରୁ ତ ଜଙ୍ଗଲ କ୍ଷୟ, ବେଆଇନ ଶି କାର ଏବଂ ବି ଶ୍ୱସ୍ତରୀୟ ଜଳବାୟୁ  ପରି ବର୍ତ୍ତ ନ ଯୋଗୁଁ  ଅନେକ ଦୁ ର୍ଲ ଭ ଜୀବଜନ୍ତୁ ଓ ଉଦ୍ଭି ଦ ପ୍ର ଜାତି  ଆଜି  ବି ଲୁ ପ୍ତି ର ଚରମ ସୀମାରେ ପହଞ୍ଚି ଛନ୍ତି । ଏହି
ସଙ୍କଟଜନକ ପରି ସ୍ଥି ତି କୁ  ନି ୟନ୍ତ୍ରଣ କରି ବା ପାଇଁ  ସଂରକ୍ଷି ତ ଜୈ ବମଣ୍ଡଳ ଅଞ୍ଚଳ, ବନ୍ୟପ୍ରା ଣୀ ଅଭୟାରଣ୍ୟର ପ୍ର ତି ଷ୍ଠା ଏବଂ ସରକାରଙ୍କ ଦ୍ୱାରା ପ୍ର ଣୀତ କଠୋର ଆଇନଗତ ବ୍ୟବସ୍ଥା ଗଛଲତା ଓ
ପ୍ରା ଣୀଜଗତକୁ  ସୁ ରକ୍ଷା ପ୍ର ଦାନ କରି ବାରେ ପ୍ର ମୁ ଖ ଭୂ ମି କା ଗ୍ର ହଣ କରୁ ଛି । ବନ୍ୟପ୍ରା ଣୀ ସଂରକ୍ଷଣର ପ୍ର କୃ ତ ଅର୍ଥ  କେବଳ ପ୍ରା ଣୀମାନଙ୍କୁ  ଆତତାୟୀଙ୍କ କବଳରୁ  ରକ୍ଷା କରି ବା ନୁ ହେଁ , ବରଂ ସେମାନଙ୍କ
ବଂଶବୃ ଦ୍ଧି  ଓ ସୁ ରକ୍ଷି ତ ଜୀବନ ପାଇଁ  ଆବଶ୍ୟକ ହେଉଥି ବା ପ୍ରା କୃ ତି କ ବାସସ୍ଥଳୀ ବା ପରି ସଂସ୍ଥାକୁ  ବଜାୟ ରଖି ବା ମଧ୍ୟ ଅଟେ। ଜୈ ବ ବି ବି ଧତାର ଅମୂ ଲ୍ୟ ଗୁ ରୁ ତ୍ୱ ଏବଂ ଏହାର ଉପକାରି ତା ବି ଷୟରେ
ସାଧାରଣ ଜନତା ଓ ସ୍ଥାନୀୟ ସମ୍ପ୍ରଦାୟକୁ  ଶି କ୍ଷି ତ ତଥା ସଚେତନ କରି ବା ଦ୍ୱାରା ପ୍ର କୃ ତି  ପ୍ର ତି  ଏକ ଦାୟି ତ୍ୱବାନ ଆଚରଣ ପ୍ରୋ ତ୍ସାହି ତ ହୋଇପାରି ବ। ମନେ ରଖି ବାକୁ  ହେବ ଯେ, ଏହି  ବି ଶାଳ
ପରି ବେଶକୁ  ସୁ ରକ୍ଷି ତ ରଖି ବା ଦି ଗରେ ପ୍ର ତ୍ୟେକ ବ୍ୟକ୍ତି ଙ୍କ କ୍ଷୁ ଦ୍ର ତମ ପ୍ର ୟାସ ମଧ୍ୟ ଭବି ଷ୍ୟତରେ ଏକ ସୁ ସ୍ଥ, ସୁ ନ୍ଦର ଏବଂ ସନ୍ତୁଳି ତ ପରି ସଂସ୍ଥା ଗଠନ କରି ବାରେ ବହୁ ମୂ ଲ୍ୟ ଅବଦାନ ଦେଇଥାଏ।
ପ୍ର କୃ ତି ର ସୁ ରକ୍ଷା ହିଁ ପ୍ର କୃ ତରେ ମାନବଜାତି ର ସୁ ରକ୍ଷା।

ପାରି ପାର୍ଶ୍ଵିକ ସନ୍ତୁଳନ ରକ୍ଷା ପାଇଁ  କଣ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ ?

A.  ଜଙ୍ଗଲକ୍ଷୟ

B.  ଶି କାର କରି ବା

C.  ବନ୍ୟପ୍ରା ଣୀ ସଂରକ୍ଷଣ

D.  ଶି ଳ୍ପାୟନ

✓

Q72 Odia
କେଉଁ  କାରଣ ଯୋଗୁଁ  ଅନେକ ପ୍ର ଜାତି  ବି ଲୁ ପ୍ତ ହେବାକୁ  ଯାଉଛନ୍ତି ?

A.  କଠୋର ନି ୟମ

B.  ଜଙ୍ଗଲ କ୍ଷୟ, ଶି କାର ଏବଂ ଜଳବାୟୁ  ପରି ବର୍ତ୍ତ ନ

C.  ଶି କ୍ଷା ଏବଂ ସଚେତନତା

D.  ଅଭୟାରଣ୍ୟ ସ୍ଥାପନ

✓

Q73 Odia
ବନ୍ୟପ୍ରା ଣୀ ସଂରକ୍ଷଣର ପ୍ର କୃ ତ ଅର୍ଥ  କଣ?

A.  କେବଳ ପଶୁ ଙ୍କୁ  ପଞ୍ଜୁ ରୀରେ ରଖି ବା

B.  କେବଳ ଗଛ କାଟି ବା

C.  ପଶୁ  ଏବଂ ସେମାନଙ୍କର ବାସସ୍ଥଳୀ ଉଭୟକୁ  ସୁ ରକ୍ଷା ଦେବା

D.  କେବଳ ଜଳବାୟୁ  ପରି ବର୍ତ୍ତ ନକୁ  ରୋକି ବା
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✓

Q74 Odia
ଜୈ ବ ବି ବି ଧତା ଶି କ୍ଷା କି ପରି  ସାହାଯ୍ୟ କରେ?

A.  ଏହା ପ୍ର କୃ ତି  ପ୍ର ତି  ଦାୟି ତ୍ୱବାନ ଆଚରଣକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରେ

B.  ଏହା ଶି କାରକୁ  ବୃ ଦ୍ଧି  କରେ

C.  ଏହା ଜଙ୍ଗଲ ନଷ୍ଟ କରି ବାରେ ସାହାଯ୍ୟ କରେ

D.  ଏହାର କୌଣସି  ପ୍ର ଭାବ ନାହିଁ

✓

Q75 Odia
ଏକ ସୁ ସ୍ଥ ପରି ସଂସ୍ଥା ପାଇଁ  କାହାର ଅବଦାନ ରହି ଛି ?

A.  କେବଳ ସରକାରଙ୍କର

B.  କେବଳ ବୈ ଜ୍ଞାନି କମାନଙ୍କର

C.  ପ୍ର ତ୍ୟେକ ବ୍ୟକ୍ତି ଙ୍କ ଛୋଟ ବଡ଼ ପ୍ର ୟାସର

D.  କାହାରି  ନୁ ହେଁ

Computer

✓

Q76 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ସି ଷ୍ଟମ ସଫ୍ଟ ୱେର୍  ଅଟେ?

A.  MS ୱାର୍ଡ

B.  ଫଟୋସପ୍

C.  ପେଣ୍ଟ

D.  ୱି ଣ୍ଡୋଜ 10

✓

Q77 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ୱି ଣ୍ଡୋଜ ଷ୍ଟାର୍ଟ  ହେବା ପରେ ସ୍କ୍ରି ନର ମୁ ଖ୍ୟ ଡି ସପ୍ଲେ  ଏରି ଆ
ଅଟେ, ଯେଉଁ ଥି ରେ ଆଇକନ, ଟାସ୍କବାର ଏବଂ ୱାଲପେପର ଦେଖାଯାଇଥାଏ?

A.  ୱି ଣ୍ଡୋ ପେନ

B.  ଡେସ୍କଟପ

C.  ରି ସାଇକଲ ବି ନ

D.  ଫାଇଲ ଏକ୍ସପ୍ଲୋ ରର

✓

Q78 Computer
ଗୋଟି ଏ ସ୍ପ୍ରେଡସି ଟରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ଏକ ବୈ ଧ ସର୍ଟିଂ ମାନଦଣ୍ଡ
ଭାବରେ ଗଣାଯାଏ ନାହିଁ?

A.  ଭାଲ୍ୟୁ  ଅନୁ ଯାୟୀ

B.  ସେଲ ରଙ୍ଗ ଅନୁ ଯାୟୀ

C.  ଫଣ୍ଟ ଆକାର ଅନୁ ଯାୟୀ

D.  ଫାଇଲ ନାମ ଅନୁ ଯାୟୀ

✓

Q79 Computer
ଏକ ପ୍ର ଫେସନାଲ ଟାଇପ୍ ‌ସେଟିଂ  ପ୍ର କଳ୍ପ ପାଇଁ  ଏହା ଆବଶ୍ୟକ ହୋଇଥାଏ ଯେ, ଗୋଟି ଏ
ପାରାଗ୍ରା ଫର ପ୍ର ତ୍ୟେକ ଧାଡ଼ି  ବାମ ଓ ଡାହାଣ ମାର୍ଜିନ ମଧ୍ୟରେ ଥି ବା ସମଗ୍ର  ଓସାର
(width) କୁ  ପୂ ରଣ କରି ବା ପାଇଁ  ଦୃ ଶ୍ୟମାନ ଭାବରେ ପ୍ର ସାରି ତ ହେବ, ଯେଉଁ ଥି ରେ
ଟେକ୍ସଟ୍ ‌ର ଶେଷ ଧାଡ଼ି  ମଧ୍ୟ ଅନ୍ତର୍ଭୁ କ୍ତ, ଯଦି ଓ ସେହି  ଧାଡ଼ି ରେ କମ ଶବ୍ଦ ଥାଏ । ଏହି  ଇଫେକ୍ଟ
ସମସ୍ତ ଅକ୍ଷର ଏବଂ ଶବ୍ଦ ମଧ୍ୟରେ ଅତି ରି କ୍ତ, ୟୁ ନି ଫର୍ମ  ସ୍ପେସ ଆଡ କରି  ଧାଡ଼ି ରେ ଟେକ୍ସଟକୁ
ସମ୍ପୂ ର୍ଣ୍ଣ  ରୂ ପେ ଡି ଷ୍ଟ୍ରି ବ୍ୟୁ ଟ କରି  ହାସଲ କରାଯାଏ । ଏହି  ସ୍ୱତନ୍ତ୍ର ଡି ଷ୍ଟ୍ରି ବ୍ୟୁ ସନକୁ  ପାରାଗ୍ରା ଫର
ସମସ୍ତ ଧାଡ଼ି ରେ ହାସଲ କରି ବା ପାଇଁ  MS 365 Word ରେ କେଉଁ  ନି ର୍ଦ୍ଦିଷ୍ଟ ପାରାଗ୍ରା ଫ୍
ଆଲାଇନମେଣ୍ଟ ଅପସନ ବ୍ୟବହାର କରାଯାଏ?

A.  Justify

B.  Distributed

C.  Align Right

D.  Center

✓

Q80 Computer
ଆପ୍ଲି  କେସନ ସଫ୍ଟ ୱେୟାର ମୁ ଖ୍ୟତଃ __________ ପାଇଁ  ବ୍ୟବହୃ ତ ହୁ ଏ ।

A.  ହାର୍ଡ ୱେର୍  ଫଙ୍କସନ ପରି ଚାଳନା କରି ବା

B.  ଅପରେଟିଂ  ସି ଷ୍ଟମକୁ  କଣ୍ଟ୍ରୋଲ କରି ବା

C.  ୟୁ ଜରମାନଙ୍କୁ  ନି ର୍ଦ୍ଦିଷ୍ଟ କାର୍ଯ୍ୟ  ସମ୍ପାଦନ କରି ବା (accomplish) ରେ ସାହାଯ୍ୟ
କରି ବା

D.  ସି ଷ୍ଟମ ସଫ୍ଟ ୱେୟାର୍  ଡେଭଲପ କରି ବା
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✓

Q81 Computer
ଡେସ୍କଟପ୍  ଏବଂ ଲାପଟପ୍  କମ୍ପ୍ୟୁ ଟର ପାଇଁ  ________ ସବୁ ଠାରୁ  ଲୋକପ୍ରି  ୟ ଅପରେଟିଂ
ସି ଷ୍ଟମ୍  ଅଟେ, ଯାହା ସମସ୍ତ ଇନଷ୍ଟଲେସନର 76% ଅଟେ ।

A.  ଆପଲ୍  ର macOS

B.  ଆପଲ୍  ର iPadOS

C.  ୱି ଣ୍ଡୋଜ୍

D.  ଲି ନକ୍ସ (ଡେସ୍କଟପ)

✓

Q82 Computer
MS Word ରେ ଏକ ନୂ ତନ ବ୍ଳା ଙ୍କ ଡକ୍ୟୁ ମେଣ୍ଟ ସୃ ଷ୍ଟି  କରି ବା ପାଇଁ  କେଉଁ  କମାଣ୍ଡ ବ୍ୟବହୃ ତ
ହୁ ଏ?

A.  File → Save

B.  File → Open

C.  File → New

D.  Insert → New Page

✓

Q83 Computer
MS ପାୱାରପଏଣ୍ଟ ସ୍ଲା ଇଡରେ ଚାର୍ଟ , ଟେବୁ ଲ୍  କି ମ୍ବା SmartArt ଇନସର୍ଟ  କରି ବା ପାଇଁ
କେଉଁ  ମେନୁ  ପାଥ ଅନୁ ସରଣ କରାଯି ବା ଉଚି ତ?

A.  Insert → Choose the object type (Chart, Table, SmartArt, etc.)

B.  File → Options

C.  View → Slide Master

D.  Design → Format Background

✓

Q84 Computer
ଏକ MS ଏକ୍ସେଲ ୱାର୍କ ବୁ କ ପ୍ରି  ଣ୍ଟ କରି ବା ପାଇଁ  ବ୍ୟବହୃ ତ ସର୍ଟ କଟ କମାଣ୍ଡ _______ ଅଟେ ।

A.  Ctrl + C

B.  Alt + P

C.  Ctrl + P

D.  File > print

✓

Q85 Computer
MS ପାୱାରପଏଣ୍ଟ 2021 ରେ ପାୱାରପଏଣ୍ଟ ପ୍ରେ ଜେନଟେସନର ଡି ଫଲ୍ଟ  ଫାଇଲ
ଏକ୍ସଟେନସନ କ'ଣ?

A.  .pptx

B.  .docx

C.  .xlsx

D.  .pdf

✓

Q86 Computer
MS PowerPoint ରେ ଆପଣ କି ପରି  ଏକ ବ୍ଳା ଙ୍କ ପ୍ରେ ଜେଣ୍ଟେସନ୍  (Blank
Presentation) ତି ଆରି  କରି ପାରି ବେ?

A.  ଫାଇଲ → ସେଭ ଆଜ → ବ୍ଳା ଙ୍କ ପ୍ରେ ଜେଣ୍ଟେସନ

B.  ଫାଇଲ → ନି ଉ → ବ୍ଲା ଙ୍କ ପ୍ରେ ଜେଣ୍ଟେସନ୍

C.  ଇନସର୍ଟ  → ନି ଉ ସ୍ଲା ଇଡ → ବ୍ଲା ଙ୍କ ପ୍ରେ ଜେଣ୍ଟେସନ୍

D.  ଡି ଜାଇନ → ନି ଉ ଥି ମ → ବ୍ଲା ଙ୍କ

✓

Q87 Computer
FTP କେଉଁ  କାମରେ ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  ଫାଇଲ ଟ୍ରା ନ୍ସ ଫର

B.  ଇମେଲ

C.  ୱେବ ବ୍ରା ଉଜିଂ

D.  ଭି ଡି ଓ ଷ୍ଟ୍ରି ମିଂ

✓

Q88 Computer
ଏକ୍ସେଲ କଲମକୁ  ସର୍ବା ଧି କ କେତେ ସାଇଜ (କ୍ୟାରେକ୍ଟର ହି ସାବରେ) ରେ ସେଟ
କରାଯାଇପାରି ବ?

A.  128

B.  255

C.  712

D.  1024

✓

Q89 Computer
କେଉଁ  ସର୍ଚ୍ଚ  ଇଞ୍ଜି ନ ମୂ ଳତଃ 'Backrub' ଭାବରେ ଜଣାଶୁ ଣା ଥି ଲା?

A.  ୟାହୁ

B.  ଗୁ ଗଲ

C.  ଆଲ୍ଟା ଭି ସ୍ତା

D.  Ask.com

✓

Q90 Computer
MS ୱାର୍ଡ ରେ ଟେକ୍ସଟ କି ପରି  ଦେଖାଯି ବ ଏବଂ ଏହା କେତେ ବଡ଼ କି ମ୍ବା ଛୋଟ ଦେଖାଯି ବ
ତାହା ପରି ବର୍ତ୍ତ ନ କରି ବା ଭଳି  Home ଟ୍ୟାବର କେଉଁ  ଗୃ ପ ଟେକ୍ସଟର ଆପି ୟରାନ୍ସ  ଆଡଜଷ୍ଟ
କରି ବା ପାଇଁ  ଟୁ ଲ ପ୍ର ଦାନ କରେ?

A.  Font

B.  Paragraph

C.  Layout

D.  Review
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Reasoning

✓

Q91 Reasoning
P, Q, R, S, T, U ଏବଂ V ଏକ ବୃ ତ୍ତାକାର ଟେବୁ ଲ ଚାରି ପାଖରେ କେନ୍ଦ୍ର ଆଡ଼କୁ  ମୁ ହଁ  କରି
ବସି ଛନ୍ତି  । Q ଙ୍କ ବାମ ପାର୍ଶ୍ୱ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ U ବସି ଛନ୍ତି  । U ଙ୍କ ଠି କ ଡାହାଣ ପାର୍ଶ୍ୱ ରେ T
ବସି ଛନ୍ତି  । T ଙ୍କ ଡାହାଣ ପାର୍ଶ୍ୱ  ଚତୁ ର୍ଥ  ସ୍ଥାନରେ P ବସି ଛନ୍ତି  । Q ଙ୍କ ନି କଟତମ ପଡ଼ୋଶୀ R
ନୁ ହଁ ନ୍ତି  । R ଙ୍କ ବାମ ପାର୍ଶ୍ୱ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ S ବସି ଛନ୍ତି  । ନି ମ୍ନ ଲି ଖି ତ ଦୁ ଇ ଜଣଙ୍କ ମଧ୍ୟରୁ
କେଉଁ ମାନେ ନି କଟତମ ପଡ଼ୋଶୀ ନୁ ହଁ ନ୍ତି ?

A.  UR

B.  TS

C.  QV

D.  SV

✓

Q92 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ତ୍ର ୟୀ ଗୁ ଡି କରେ, ପ୍ର ତ୍ୟେକ ଅକ୍ଷର ସମୂ ହ ଏକ ନି ର୍ଦ୍ଧିଷ୍ଟ ତର୍କ  ଆଧାରରେ
ପରବର୍ତ୍ତୀ  ଅକ୍ଷର ସମୂ ହ ସହି ତ ସମ୍ପର୍କିତ । ସମାନ ତର୍କ  ଅନୁ ସରଣ କରୁ ଥି ବା ବି କଳ୍ପଟି କୁ
ଚୟନ କରନ୍ତୁ ।
BAYS - AYBS - SYAB
CLAP - LACP - PALC

A.  INTO - NTIO - OTNI

B.  SEAT - SAET - TAES

C.  BUSY - UBSY - YUSB

D.  BURN - URBN - URNB

✓

Q93 Reasoning
ଗୋଟି ଏ କୋଠାର ଛଅଟି  ଭି ନ୍ନ ମହଲାରେ G, H, I, J, K ଓ L ରୁ ହନ୍ତି  । କୋଠାର ସବୁ ଠାରୁ
ତଳ ମହଲାକୁ  ନମ୍ବର 1, ଏହାର ଉପର ମହଲାକୁ  ନମ୍ବର 2 ଏବଂ ଏହି ପରି  ଭାବରେ ସବୁ ଠାରୁ
ଉପର ମହଲାକୁ  ନମ୍ବର 6 ରଖାଯାଇଛି  ।
H ଓ L ରହୁ ଥି ବା ମହଲାର ଗୁ ଣଫୁ ଳ 10 ଅଟେ । J ଙ୍କ ଠି କ ଉପରେ G ରୁ ହନ୍ତି  । I ଓ H
ରହୁ ଥି ବା ମହଲାର ସମଷ୍ଟି  11 ଅଟେ ।
L ତଳେ କେତେ ଜଣ ଲୋକ ରୁ ହନ୍ତି ?

A.  1

B.  2

C.  3

D.  4

✓

Q94 Reasoning
ଯଦି  ସଂଖ୍ୟା 6173254 ର ପ୍ର ତ୍ୟେକ ଯୁ ଗ୍ମ  ଅଙ୍କରେ 2 ଯୋଗ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ
ଅଯୁ ଗ୍ମ  ଅଙ୍କରୁ  1 ବି ୟୋଗ କରାଯାଏ, ତେବେ ଏହି ପରି  ଭାବରେ ଗଠି ତ ନୂ ତନ ସଂଖ୍ୟାଟି ର
ବାମ ପାର୍ଶ୍ୱ ରୁ  ଦ୍ୱି ତୀୟ ଅଙ୍କ ଏବଂ ଡାହାଣ ପାର୍ଶ୍ୱ ରୁ  ପ୍ର ଥମ ଅଙ୍କର ଯୋଗଫଳ କେତେ ହେବ?

A.  10

B.  8

C.  12

D.  6

✓

Q95 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମରେ ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ କ'ଣ ହେବ?
VXR TUQ RRP POO ?

A.  NLN

B.  MKJ

C.  TRE

D.  TTY

✓

Q96 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ,
A @ B ର ଅର୍ଥ  ‘A B ଙ୍କ ବାପା ଅଟନ୍ତି ’
A & B ର ଅର୍ଥ  ‘A B ଙ୍କ ପତ୍ନୀ ଅଟନ୍ତି ’
A # B ର ଅର୍ଥ  ‘A B ଙ୍କ ଝି ଅ ଅଟନ୍ତି ’
A % B ର ଅର୍ଥ  ‘A B ଙ୍କ ପୁ ଅ ଅଟନ୍ତି ’

ଉପୋରକ୍ତ ଆଧାରରେ, ଯଦି  ‘P # Q % R & S @ T’ ହୁ ଏ, ତେବେ P ସମ୍ପର୍କ ରେ T ଙ୍କର
କ'ଣ ହେବ?

A.  ଭଉଣୀ

B.  ଝି ଅ

C.  ଭାଇଙ୍କ ଝି ଅ

D.  ବାପାଙ୍କ ଭଉଣୀ

✓

Q97 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ 'sip field hip' କୁ  'tm zc is' ଭାବରେ ଏବଂ 'sir hip
yak' କୁ  'xz uu zc' ଭାବରେ କୋଡ କରାଯାଇଛି  । ଦି ଆଯାଇଥି ବା ଭାଷାରେ 'hip' କୁ
କି ପରି  ଭାବେ କୋଡ କରାଯି ବ?

A.  xz

B.  zc

C.  tm

D.  is

✓

Q98 Reasoning
ପ୍ର ଦତ୍ତ ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ ଗୁ ଡି କୁ  ଧ୍ୟାନର ସହି ତ ଅଧୟନ କରନ୍ତୁ । ଏହା ସାଧାରଣତଃ
ଜଣାଶୁ ଣା ତଥ୍ୟ ଠାରୁ  ଭି ନ୍ନ ମନେହେଲେ ସୁ ଦ୍ଧା ବି ବୃ ତି ରେ ପ୍ର ଦତ୍ତ ତଥ୍ୟ କୁ  ସତ୍ୟ ବୋଲି
ବି ବେଚନା କରନ୍ତୁ ଏବଂ ପ୍ର ଦତ୍ତ ବି ବୃ ତି  (ଗୁ ଡି କୁ ) କୁ  ତର୍କ ସଙ୍ଗତ ଭାବରେ କେଉଁ  ନି ଷ୍କର୍ଷ
(ଗୁ ଡି କ) ଅନୁ ସରଣ କରୁ ଛି  ତାହା ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।
ବି ବୃ ତି : କି ଛି  ବୀଜଗଣି ତ ଜ୍ୟାମି ତି  ଅଟେ । କି ଛି  ଜ୍ୟାମି ତି  କାଲକୁ ଲି  ଅଟେ ।
ନି ଷ୍କର୍ଷ  I: କି ଛି  ବୀଜଗଣି ତ କାଲକୁ ଲି  ଅଟେ ।
ନି ଷ୍କର୍ଷ  II: କୌଣସି  ବୀଜଗଣି ତ କାଲକୁ ଲି  ନୁ ହେଁ  ।

A.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ

B.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ

C.  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) କୌଣସି ଟି  ଅନୁ ସରଣ କରେ ନାହିଁ

D.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଏବଂ (II) ଅନୁ ସରଣ କରେ
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✓

Q99 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ
ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି  ସେହି
ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ  ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  EGJ

B.  MOQ

C.  ACE

D.  PRT

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । ଗଣନା କେବଳ ବାମରୁ
ଡାହାଣକୁ  କରାଯି ବ ।
(ବାମ) Z X C V B N M A S D F G H J K L Q W (ଡାହାଣ)
ଏପରି  କେତୋଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ  ଅଛି  ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ  ଅଛି
ଏବଂ ଠି କ ପରେ ଏକ ସ୍ୱରବର୍ଣ୍ଣ  ଅଛି ?

A.  କି ଛି  ନାହିଁ

B.  ଏକ

C.  ଦୁ ଇ

D.  ତି ନି
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